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Legal notices

Copyright notice

© Copyright 2008-2022 Micro Focus or one of its affiliates.

The only warranties for products and services of Micro Focus and its affiliates and licensors (“Micro Focus”)
are set forth in the express warranty statements accompanying such products and services. Nothing herein
should be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or
editorial errors or omissions contained herein. The information contained herein is subject to change without
notice.

Adobe™ is a trademark of Adobe Systems Incorporated.

Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.

UNIX® is a registered trademark of The Open Group.

This product includes an interface of the 'zlib' general purpose compression library, which is Copyright ©
1995-2002 Jean-loup Gailly and Mark Adler.

Documentation updates
The title page of this document contains the following identifying information:
l Software Version number, which indicates the software version.
l Document Release Date, which changes each time the document is updated.
l Software Release Date, which indicates the release date of this version of the software.

You can check for more recent versions of a document through the MySupport portal. Many areas of the
portal, including the one for documentation, require you to sign in with a Software Passport. If you need a
Passport, you can create one when prompted to sign in.

Additionally, if you subscribe to the appropriate product support service, you will receive new or updated
editions of documentation. Contact your Micro Focus sales representative for details.

Support
Visit the MySupport portal to access contact information and details about the products, services, and
support that Micro Focus offers.

This portal also provides customer self-solve capabilities. It gives you a fast and efficient way to access
interactive technical support tools needed to manage your business. As a valued support customer, you can
benefit by using the MySupport portal to:

l Search for knowledge documents of interest
l Access product documentation
l View software vulnerability alerts
l Enter into discussions with other software customers
l Download software patches
l Manage software licenses, downloads, and support contracts
l Submit and track service requests
l Contact customer support
l View information about all services that Support offers

Many areas of the portal require you to sign in with a Software Passport. If you need a Passport, you can
create one when prompted to sign in. To learn about the different access levels the portal uses, see the
Access Levels descriptions.
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Specifications

Introduction

Micro Focus or one of its affiliates Content Manager contains powerful and useful functions for
electronic document and records management.

Because Content Manager can and should be configured in a number of ways depending on your
requirements, the functions have been designed to be flexible without compromising rigorous document
and records management standards.

Please note that Content Manager is designed to operate within the parameters of sound information
management principles and that attempts to extend Content Manager beyond these parameters will
adversely affect its implementation .
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Recommended minimum requirements

NOTE: For all machines which have Content Manager components installed, it is mandatory
that theWindows® operating systems have the latest Universal C Runtimes update installed.
For additional information regarding this update, please see https://support.microsoft.com/en-
us/kb/3118401

Main applications

Content Manager client (32-bit)

Component Requirement

Operating system Windows 10 (32-bit) Professional or Enterprise

Processor Business class processor

Memory 2GB RAM

Disk space 2GB free space

Sufficient space for configuration, document
caching and logging.

Display Graphics device capable of displaying a
resolution of 1280 x 768 or higher

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

ForWebClient requirements, see Content ManagerWebClient Browser Support.
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Content Manager client (64-bit)

Component Requirement

Operating system Windows 10 (64-bit) Professional or Enterprise

Windows 11 (64-bit) Professional or Enterprise

Processor Business class processor

Memory 2GB RAM

Disk space 2GB free space

Sufficient space tomanage configuration,
document caching and logging.

Display Graphics device capable of displaying a
resolution of 1280 x 768 or higher

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

ForWebClient requirements, see Content ManagerWebClient Browser Support.
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Content Manager Workgroup Server (64-bit)

A Content Manager implementationmust have at least one Content ManagerWorkgroup Server, but
may have several depending on the number of Content Manager clients and their geographical
distribution.

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

Processor Business class server processor

Memory 4GB RAM or greater

Disk space 2GB free space for installation
Sufficient space tomanage configuration, stores
and logs.

Display Graphics device capable of displaying a
resolution of 1280 x 768 or higher

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

NOTE: The Document Rendering event requires the Onstream printer files to process events
correctly. The required files are installed by default when usingSetup_FT_CM_x64.exe. If
you're installing Content Manager using the .msi files, theOnstreamPrinterFiles_x64.msi
must be installed as well.

Peripheral applications

Content Manager comes with a number of peripheral applications, which you can choose to install
during client or server installation, or youmay need to use one of the separate .msi files from the
installationmedia.
Some of these have additional requirements.
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Content Manager Web Client Server (64-bit)

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

Microsoft Internet Information Services (IIS)
Version 10.0

For IIS 10: Windows Server 2016
For IIS 10: Windows Server 2019
For IIS 10: Windows Server 2022

Content Manager Content ManagerWorkgroup Server

Installation prerequisite Microsoft .NET Framework 4.6.2

Content Manager Web Client Browser Support

Component Requirement

Browser Google Chrome version 85.0 or above
Microsoft Internet Explorer version 11.1016 or
above
Microsoft Edge (Chromium open source engine)
version 85.0 or above
Mozilla Firefox version 77.0 or above

Smartphone iPhone/iOS 14.1. running Google Chrome
v86.0.4240.93

Tablet iPad/iOS 14.1 running Google Chrome
v86.0.4240.93

*Please see Limitations and Behaviors –WebClient for a known limitation with Google Chrome v51+
onmobile devices.

Content ManagerWebClient is fully responsive to aminimum screen resolution of 768px by 991px.

NOTE: TheCheck Out and edit option is supported using Internet Explorer 11.
The supported Office applications are Office 2013 SP1, 2016 and 2019.
The supported Office Online version is 16.0.7766.8550 and later.

Content Manager for SharePoint (64-bit)
SharePoint Online
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Component Requirement

SharePoint version SharePoint Online

Microsoft Office Any version supported by SharePoint Online

Browser Internet Explorer 11 and Edge are the only
browsers supported when using configuration or
information pages provided by the app.
SharePoint users who do not need these pages
can use any browser supported by the version of
SharePoint.

SharePoint 2013, SharePoint 2016 or SharePoint 2019 on premise

Component Requirement

SharePoint version SharePoint 2013 SP1, SharePoint 2016 or
SharePoint 2019

Operating system Any operating system supported by SharePoint
2013 SP1, SharePoint 2016 or SharePoint 2019

Microsoft Office Any version supported by SharePoint 2013 SP1,
SharePoint 2016 or SharePoint 2019

Browser Internet Explorer 11 and Edge are the only
browsers supported when using configuration or
information pages provided by the app.
SharePoint users who do not need these pages
can use any browser supported by the version of
SharePoint.

Content Manager Servers in support of SharePoint 2013, SharePoint 2016 or SharePoint 2019

Component Requirement

Operating System Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

Ancillary components Content ManagerWorkgroup Server
A SQL Server instancemust be available on the
same or a remote computer. Supported versions:

SQL Server 2016
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SQLServer 2017
SQL Server 2019

Content Manager Service API

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

Microsoft Internet Information Services (IIS)
version 10

For IIS 10.0: Windows Server 2016 (64-bit)
For IIS 10.0: Windows Server 2019 (64-bit)
For IIS 10.0: Windows Server 2022 (64-bit)

Installation prerequisites for .msi installation Available for download:
Windows installer 5.0
Microsoft .NET Framework 4.6.2

ForWebClient requirements, see Content ManagerWebClient Browser Support.

Content Manager WebDrawer (64-bit)

Component Requirement

Operating System Support Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

Microsoft Internet Information Services (IIS)
version 10

For IIS 10.0: Windows Server 2016 (64-bit)
For IIS 10.0: Windows Server 2019 (64-bit)
For IIS 10.0: Windows Server 2022 (64-bit)
Role IIS Management selected

Prerequisites Content ManagerWorkgroup Server must be
installed with this application
Microsoft .NET Framework 4.6.2
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Integrations

Content Manager integrates with a number of applications, which you can choose to install during client
or server installation, or youmay need to use one of the separate .msi files from the installationmedia.

Some of these have additional requirements.

Content Manager Office integration

Component Requirement

Operating system Same as Content Manager 32-bit or 64-bit client

Microsoft Office support Office 2013 SP1(32-bit or 64-bit)
Office 365 (Full, installed Office on PC, 32-bit or
64-bit)
Office 2016 (32-bit or 64-bit)
Office 2019 (32-bit or 64-bit)

With a 32-bit version of Content Manager client,
youmust run a 32-bit version of Microsoft Office .
With a 64-bit version of Content Manager client,
youmust run a 64-bit version of Microsoft Office .

You can run 32-bit versions of Content Manager
on supported 64-bit operating systems, and then
integrate with 32-bit Office as supported by
Microsoft.

Installation prerequisite Content Manager client (32-bit or 64-bit)

Content Manager Zero foot print Office add-in

Component Requirement

Operating system Windows 10 version 1903 or later

Microsoft Office support Office 365*

Browser Google Chrome version 88.0.4324.150
Microsoft Edge version 88.0.705.68

* NonO365Office desktop, for example Office 2016 or 2019, are not supported.
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Content Manager EmailLink email integration

Component Requirement

Microsoft Exchange Server ExchangeOnline
Exchange 2016
Exchange 2019

GoogleMail (Gmail) Gmail for Business

Content Manager ArchiveLink integration (64-bit)

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

SAP support KGS Content Server 4.0.5 or later

Prerequisites Tomcat 6.x, 7.x and 8.x
Content ManagerWorkgroup Server

Content Manager Kofax integration (32-bit)

Component Requirement

Operating system Windows 10 Professional or Enterprise (32-bit or
64-bit)

Kofax Capture support Versions 11.0 and 11 SP1

Prerequisites Content Manager client (32-bit)
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Content Manager Warehouse integrations (64-bit)

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

Prerequisites Content Manager core libraries installed using
Setup_FT_CM_x64.exe

Content Manager IDOL integration

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a no
GUI flavour of Windows Server, is
not supported.

IDOL support IDOL 12.7 Enterprise or OEM
Content Manager uses IDOL 12.7 OEM for
the following Content Manager features:
—Document content indexing
—Optical Character Recognition (by using
IDOLMedia Server)
—Auto Classification (by using IDOL
Automatic Categorization)
Older versions of IDOL Enterprise are
supported on principle, but they may not
support the above Content Manager
features.

Prerequisite Content Manager client (64-bit)

Elasticsearch

Content Manager 10.0 supports Elasticsearch 7.x.
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ControlPoint integration with Content Manager (64-bit)

This integration requires ControlPoint version 5.9 or later.

Structured Data Manager integration with Content Manager

For the details on supported versions, referStructure DataManager CertificationMatrix available at
Documentation Portal.

EMC Centera integration (64-bit)

Component Requirement

Operating system Windows Server 2016 (64-bit)
Windows Server 2019 (64-bit)
Windows Server 2022 (64-bit)

NOTE:Windows core, which is a noGUI
flavour of Windows Server, is not
supported.

EMC Centera support Version 3.4 or later

Installation prerequisites Content ManagerWorkgroup Server (64-bit)

Content Manager document viewer supported file formats

Content Manager uses KeyView 12.7.

64-bit support

Youwill find the 64-bit .msi files on the installation CD. Their file names end in _x64.

Content Manager 32-bit applications run on 64-bit operating systems; however, Content Manager 64-bit
applications do not run on 32-bit operating systems.

Content Manager 32-bit clients and Content Manager 64-bit clients can connect to a Content Manager
64-bit server.

Other Environment

Content Manager in virtual environments

Micro Focus Software undertakes both development and testing of Content Manager in VMWare
virtualized environments.

Where an operating system supported for Content Manager is virtualized, this should be transparent to
Content Manager; and this has beenMicro Focus or one of its affiliates's experience to date. Micro
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Focus has numerous customers worldwide successfully using Content Manager in virtual
environments, with few or no issues. To date, all issues that have arisen have been resolved by
reconfiguration of either the virtual host environment or the hosting hardware itself.

With regard to system performance, running Content Manager in a virtual environment is likely to result
in increased CPU utilization or other hardware resource consumption. This can result in a reduction in
system workload capacity; hence a corresponding increase in transaction response times. Micro
Focus strongly encourages customers and partners to gather baseline performance statistics for
Content Manager in both conventional and virtual environments, and satisfy themselves as to the
stability and performance of selected virtual environments before using them for production
implementations.

If an issue arises in a virtual environment that does not also occur in a conventional environment; Micro
Focus or one of its affiliates cannot guarantee a resolution to the issue. Where it is apparent that a
particular issue is specific to virtualization technologies, Micro Focus or one of its affiliates may ask the
customer to reproduce the issue in a non-virtualized environment before committing further support
resources.

Content Manager and Citrix

Micro Focus neither formally test nor certify Content Manager on any version of Citrix; nor do we
produce documentation about deploying Content Manager in Citrix. It is the customer's responsibility to
perform in-house testing in their own network environment with their own version of Citrix before
deciding whether Citrix is a suitable deployment platform for Content Manager in their organization.

Micro Focus or one of its affiliates Support makes every reasonable effort to assist a customer who
reports an issue with Content Manager where it has been deployed using Citrix, but we do not support
the Citrix environment itself. Micro Focus or one of its affiliates's past experience with Content
Manager sites using Citrix suggests that when Citrix is configured correctly, e.g. user profiles, home
drives, printers etc. behave similarly to a non-Citrix desktop environment, and Content Manager is
deployed in a desktop that includes any applications to be integrated with Content Manager, e.g.
Microsoft Office suite and email, there should not be any significant issues.

If an issue arises with Content Manager in a Citrix environment that does not also occur with a
conventional Content Manager installation, Micro Focus or one of its affiliates cannot guarantee a
resolution to the issue. Where it is apparent that a particular issue is specific to the Citrix deployment,
Micro Focus or one of its affiliates reserves the right to ask the customer to reproduce the issue in a
non-Citrix environment before committing further support resources.

For more information on this subject, see theMicro Focus or one of its affiliates Software Support
article at https://softwaresupport.softwaregrp.com/km/KM1456476

Relational Database Management System (RDBMS)
requirements

Supported RDBMS servers (64-bit)

l SQL Server 2016

l SQL Server 2017

Specifications and Limitations

Content Manager (10.0) Page 17 of 55

https://softwaresupport.softwaregrp.com/km/KM1456476


l SQL Server 2019

l Microsoft Azure SQL Database

l Amazon RDS for SQL Server

l Oracle 18c

l Oracle 19c

l Oracle CDB/PDB (Pluggable database created in container database)

l PostgreSQL 12

NOTE:When creating a SQL Server database for Content Manager, it is strongly
recommended that you use a case-insensitive (CI) collation sequence.

Minimum Requirements for database access

For SQL Server:

The user assigned to the database should at least have the following permission:

l db_owner

For Oracle:

The role assigned to the schema used should at least have the following permissions:

l Alter Session

l Create Session

l Create Procedure

l Create Sequence

l Create Table

l Create View

l Create Job

l EXECUTE ON CTXSYS.CTX_DDL

l SELECT ON SYS.DBA_REGISTRY

For PostgreSQL:

The role assigned to the database should at least have the following permission:

l Superuser

Supported RDBMS clients (64-bit)

The Content ManagerWorkgroup Server requires RDBMS client drivers to connect to its databases.
The drivers are dependent on the type of RDBMS in use. For example:

For SQL Server, Azure SQL and Amazon RDS for SQL Server
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Content Manager relies onOpen Database Connectivity (ODBC) to access the databases. It is
recommended to useODBC Driver 17.5 or 17.6. It can be downloaded from
https://www.microsoft.com/en-us/download/details.aspx?id=56567

For Oracle

IMPORTANT: If you are running the process index text, bulk loading, migration, or temp table
with bulk load support, the Oracle client must be installed on theWorkgroup Server that
includes the SQL Loader.
If you are using the Oracle OCI connector you cannot run an index text, bulk load or migrate
from that Workgroup Server.

NOTE: Make sure that in Oracle the system parameterCURSOR_SHARING is set toEXACT
as only supports the valueEXACT forCURSOR_SHARING.

Content Manager relies on the Oracle Call Interface (OCI) to access the databases. There are two
methods available to facilitate this:

1. By default, we include the Oracle Instant Client as part of our software. This means no additional
client software is required and the connection string will require an IP address of the Oracle server.

2. If the user wishes to rely onOracle’s Transparent Network Substrate (TNS), they will require a
separate Oracle Client installation (excluding the Instant Client). They will also need to setup a
System Environment Variable on theWorkgroup Server, such as follows:
Variable name: ORACLE_HOME

Variable value: C:\oracle\product\12.1.0\client_1

The variable value comes from theOracle client’s Installation registry entry (this is dependent on
the installed environment) e.g.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\KEY_OraClient12Home1

For PostgreSQL

Content Manager relies onODBC to access the databases. We recommend using psqlODBC. It can
be downloaded from https://odbc.postgresql.org/

Special Database Considerations

For SQL Server’s Geographic Information System (GIS) implementation

Content Manager supports GIS data in SQL Server databases. There are no additional installation
requirements.

For Oracle’s Geographic Information System (GIS) implementation

Content Manager supports GIS data in Oracle databases.

To facilitate this, one of the following Oracle products must be installed:

l Oracle Spatial andGraph – supports a wide range of spatial and graph analytics and has Licence
requirements. Please refer to the following documentation for more information:
http://docs.oracle.com/database/122/SPATL/toc.htm

Specifications and Limitations

Content Manager (10.0) Page 19 of 55

https://www.microsoft.com/en-us/download/details.aspx?id=56567
https://odbc.postgresql.org/
http://docs.oracle.com/database/122/SPATL/toc.htm


l Oracle Locator – a free version of the basic Spatial features: Please refer to the following link for
details: http://docs.oracle.com/database/122/SPATL/oracle-locator.htm#SPATL340

For PostgreSQL’s Geographic Information System (GIS) implementation

Content Manager supports GIS data in PostgreSQL databases.

To facilitate this, the following PostgreSQL extensionmust be installed:

l PostGIS 2.3 bundle for PostgreSQL 9.6 (64-bit) from Stack Builder 4.0’s Spatial Extensions.

l Next, the administrator needs to enable the ‘postgis’ Extension in the database. This can be done by
either of the followingmethods:
o Running a script.

o Selecting a check box in the pgAdmin 4 interface.

Please refer to the following link for alternative sources andmore information: http://postgis.net/

For Microsoft Azure SQL Database

Microsoft Azure SQLDatabase is highly compatible with later versions of Microsoft SQL Server. As
such, Content Manager works with SQLDatabase almost identically to a Content Manager SQL Server
implementation. SQLDatabase does have onemain limitation that change the way Content Manager
works.

No support for CREATE TEMPORARY TABLE - this means that instead of creating temporary
tables, Content Manager has to create new tables that work in a similar way to temporary tables. This
means that it is possible that some of the in-memory efficiencies of temporary tables are not available
and it alsomeans that the Content ManagerWorkgroup Server needs tomanage the clean up of these
tables. These temporary tables have a prefix of TSTEMP_ andmay sometimes need to bemanually
cleanup up in cases of abnormal process terminations.

For Amazon RDS for SQL Server

Amazon RDS for SQL Server is highly compatible with later versions of Microsoft SQL Server. As
such, Content Manager works with Amazon RDS for SQL Server almost identically to a Content
Manager SQL Server implementation. Amazon RDS does have twomain limitations that change the
way Content Manager works.

No support for CREATE TEMPORARY TABLE - this means that instead of creating temporary
tables, Content Manager has to create new tables that work in a similar way to temporary tables. This
means that it is possible that some of the in-memory efficiencies of temporary tables are not available
and it alsomeans that the Content ManagerWorkgroup Server needs tomanage the clean up of these
tables. These temporary tables have a prefix of TSTEMP_ andmay sometimes need to bemanually
cleanup up in cases of abnormal process terminations

No support for BULK INSERT- Amazon RDS does not support the BULK INSERT command and so
a special version of this function is provided by Content Manager for Amazon RDS for SQL Server
implementations. It provides the same functionality, however it cannot emulate the performance of the
standard BULK INSERT of SQL Server.
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Limitations and Behaviors

Authentication

l ADFS authentication and/or connecting to aWorkgroup Server via HTTPS are indicators that a user
is connecting to a Cloud version of Content Manager, and in the cloud, the client computer will not be
able to access certain resources that exist in the Cloud, e.g. the URL of the IDOL Index Server, or
the file system path that is used when adding objects to a Document Store. The time out settings on
ADFS OAUTH tokens comewith can also cause issues for long running Content Manager
programs, as the program gets a timeout during running and the user cannot log again. As a result, a
number of tasks on the Administration tab in the Content Manager client will not be displayed if you
are accessing the client using ADFS authentication, or connecting to theWorkgroup Server via
HTTPs, or you are using Explicit Windows Authentication.
These tasks include:
o Setup group:

n Document Stores

o IDOL Indexes group:
n IDOL Record Reindex

n IDOL Category Training

n IDOL User Reindex

o Conversions group:
n SAP Metadata Conversion

n Saved Search Conversion

n Security Filter Converter

n Mail Message Format Conversion

o Inactive Records group:
n Electronic

n Physical

o Other group:
n Import/Export

n Recalculate Disposal Dates

n Manage Thumbnails

Product Accessibility

We’re committed to developing products that are accessible to everyone. Content Manager has been
developed to be compatible with accessibility products that implement Microsoft UI Automation
(UIA) APIs.
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To request an Accessibility Conformance report for Content Manager, please go to the Accessibility
Conformance Reports site.

Supported Languages

In regards to the English language choices within our software, by design, we follow theOxford
Dictionary which accepts the US spelling as equivalent in both languages and therefore somewords
are not converted if the language is changed between English (US) and English (International), for
example Favorites.

Released Version Supported Languages

10.0 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

NOTE:
The Content Manager includes the following
language installers inCM_LanguageMSIs.zip of
the release package:

l CM_LanguageFiles_xNN.msi - Content
Manager client and server

l CM_ThinOfficeMultiLanguage_xNN.msi - Thin
Office integration

l CM_WebClient_Languages_xNN.msi - Web
Client

l CM_SharepointMultiLanguage_xNN.msi -
SharePoint

10.0 English (International), English (United States)

9.4 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

9.4 English (International), English (United States)

9.3 (multi-language).x English (International), English (United States), Dutch,
French, Spanish

9.3 English (International), English (United States)

9.2 English (International), English (United States)

9.1 English (International), English (United States)

9.0 (multi-language).x English (International), English (United States), Dutch,
French, Spanish
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NOTE: The Content ManagerWebClient and Thin
Office integration only supports Dutch, French and
Spanish from 9.0 Patch 1. TheCM_
ThinOfficeMultiLanguage_xNN.msi andCM_
WebClient_Languages_x64.msi cannot be
installed for the 9.0 version.
The translated language files for Content Manager
SharePoint integration will be available as a part of
the SharePoint installationMSIs for 9.0 Patch 1.
You will need to install theCM_LanguageFiles_
xNN.msi after you’ve upgraded your Content
Manager SharePoint environment to version 9.0
Patch 1.
The translated language files for the Content
Manager client can be installed usingCM_
LanguageFiles_xNN.msi to any release of the 9.0
version.

9.0 English (International), English (United States)

8.3x English (International), English (United States), Dutch**,
French**, Spanish**

* software only (documentation has not been localized)

** the language pack installers for the translated files are available on the relevant version ISO or can be
downloaded from https://softwaresupport.softwaregrp.com/ These language pack installers can be
used to install the currently supported languages to any release of the relevant version, for example, the
language files for 8.2 can be installed for 8.2, 8.2 Patch 1 etc.

Unicode support

Content Manager canmanage any Unicodemetadata and content, as long as the database is
configured to support Unicode characters. Without the database supporting Unicode characters,
Content Manager will regard these characters as invalid and an error message will be displayed.

NOTE: Content Manager Title and Notes word indexing relies on word splitting using spaces
and punctuation, and does not have capability to correctly index data that does not split words
using spaces or punctuation. If you’re using IDOL to document content index your Content
Manager objects, they will be indexed, but if you want to search for them you’ll need to have the
appropriate Asian language packs installed with IDOL so it can properly understand how to split
the words. For additional information about IDOL and Asian languages, refer to the IDOL
Customer network on https://softwaresupport.softwaregrp.com/manuals

Installation

l The versions of all Content Manager peripheral applications, components and integrations on the
computer have to be the same as the version and build number of themain Content Manager
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application on the same computer

l When installing, upgrading, repairing or removing Content Manager applications, all applications on
the computer should be closed

License Keys

l When applying a new License Key for a pre-8.2 version of Content Manager, the Global Settings are
not retained and will need to be reconfigured and deployed after the License Key has been applied.

Help

l F1 does not display correct Help topic on right-click menu options – when you press F1 to display
the associated help topic for a right-click menu item, the topic that appears instead is for the list
panes and view panes, which is on the screen behind the floating right-click menu. This is a known
limitation.

l Due to the nature of the translation process, Help files in languages other than Englishmay not
contain the latest content and in rare cases, links may not work correctly. For the latest content,
consult the Help file in an English version.

l Our own document OurOwn.pdf is a sample document that you can replace with your organization’s
own document for users to access their own procedures using the Content Manager Help file. The
link from the Content Manager Help file toOurOwn.pdfworks when Content Manager is installed in
the default folderProgram Files\Micro Focus\Content Manager; however, the link does not work
when Content Manager is installed in a different folder unless you edit theStart In parameter in the
shortcut to the new Content Manager folder path.

l TheOurOwn.chm runtimemerge facility has been tested to work when developed with the help
authoring tool Madcap Flare. Other help authoring tools are not guaranteed to work.

Access control and security

l Downgrading a user’s security profile – when you downgrade the security profile of a user and they
have records marked to them that are of a higher security level than the users, then no security
violation warningmay appear.
For example, create a record within a Record Type which has top secret profile settings making
User theAssignee Location. User has a top secret profile. Then downgradeUser toUnclassified.
The record now has anAssignee Location with a lesser security profile than itself. However, you
can use the Content Manager system option in theSecurity tabWhen changing Assignee, Home
orOwner for a Record to a less secure Location to set up Content Manager to display a warning
or even prevent the downgrade.

l Access Controls and record creation and default Retention Schedules - Access Control on a
Retention Schedule that is set as a default for a Record Type will not prevent users from creating
records of that Record Type if theRetention Schedule field is not on the New Record form. Adding
theRetention Schedule field to the New Record form for the Record Type will prevent users from
creating records of that Record Type using the default Retention Schedule.
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l Access Restrictions and US DoD 5015.2 compliance – whenAdministration → System Options
→ Features tab, Classified Security orCompliance tab, Implement US DoD 5015.2
compliance, or both are selected, Content Manager operates according to the US DoD 5015.2
software application design criteria standard.

Records and containers

Containers are generally used to collect material related to a complex business transaction in order that
the entirety of the transaction can be well understood at a later point in time. As such, containers rarely
exceed 300 documents. Some customers create containers to collect similar but unrelated documents
together for the convenience of bulk disposal.

Content Manager is designed to support both of these requirements, however some limitations become
evident when creating very large containers (over 1000 documents), as some user interface elements
are built with a smaller container size in mind. For example, navigating to the contents of a container
will display the contents in descending chronological date order – this sort increases the response time
as the container gets bigger.

It is recommended to organizations that have a business requirement to create large containers that
they do not apply individual retention rules to the contents. This can lead to delays in reviewing
contents at time of disposal, particularly if you choose to archive based on an aggregated disposal
schedule.

However, if you really need to use containers with large numbers of records in Content Manager, you
can improve performance with the optionOptimize management of contained Records to allow for
very large folder sizes in theSystem Options -Container tab.

See Content Manager Help for more details about this option.

It is generally also recommended not to use toomany container levels.
A typical implementation uses three container levels:

l Documents

l Folders

l Archive Boxes

More container levels may lead to performance degradation when Content Manager performs recursive
comparison such as checking security or retention rules across multiple aggregation levels.
Content Manager checks retention rules recursively down through amaximum of four container levels.

l Record creation and Record Types usingNumbering by Container - when you number records by
container and then change the number of the container, the contained records will not have their
corresponding record numbers updated to reflect the new container number.
Similarly, when you change the record’s container, this will not update the record’s number either. In
these circumstances, it is best to manually renumber the contained records.

l Record titles usingClient titling - changing a Location namewill not change any records created
using the Location as the Client title. The change will, however, be reflected in theProperties dialog
of the record; but not in the title displayed in the view or list panes. Searching by Client Contact with
the new Location namewill find the record.
Tomanually rectify this:
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1. Find any records created using the Location

2. Modify the Location name

3. Right-click one of the records and select Properties. In theClient field, delete any Location item
and then use KwikSelect to choose themodified Location

4. Click OK to save the change

5. The record title will change accordingly and will now show the correct Location

l Copy record - copying record relationships behavior - whenCopy Relationships is selected when
copying a record, only the is Related To relationship type is copied.
An exception is when creating a new version, in which case any IsTempCopy relationship is
copied.
This is to avoid potential conflicting or incorrect relationships being created by the copy operation.
For example, if record A has a supersedes relationship with record B and a user then copies record
B to create record C, then does record A supersede record C?

l Copy record -Date Due for Destruction andDate Inactive are not copied from the original record
when a new part, new version or record copy are performed. For a new part, Content Manager does
not copy Date Published, either.
While the process of copying a record creates a blank Date Due for Destruction field, any pre-
determined states will enter an appropriate date, for example, a Retention Schedule attached to a
record being copied, default Retention Schedule on a record, etc.

l Notes field limitation – theNotes field is limited to 64 KB (65536 characters). If a user exceeds this
limit, themessageAn attempt to set the Notes text to contain XX KB failed. Notes text cannot
exceed 64KB (65536 characters). The Notes text will be truncated at this limit appears.

New Record forms

l Scroll bars - when there aremore fields on the form than can be shown in the standard size New
Record form dialog box, the New Record forms will have vertical and horizontal scrollbars allowing
the users to scroll through the fields on the form.
If, however, toomany fields are on the form, the dialog box may have problems displaying all the
fields.

l Mandatory container fields - when selectingContainer Numbering for a Record Type, the Record
Type will automatically enter Container as amandatory field for the new New Record form.
However, if you change the numbering to a different type, then Content Manager does not remove
theContainer field from the form automatically and therefore, you need to remove it manually.

l Assignee Location on a New Record form filled in and then replaced - when there is anAssignee
field on a form first and there is actually a Location there that was added according to the system
rules for enclosed - that is, that require the user to set an Assignee to keep a record from being
enclosed automatically - then when a user types in a container for the record, it removes the
allocated Assignee and replaces it with the container number.
To rectify this, you need re-assign the record.

l Enclose option - when on a New Record form, theEnclosed option will override the record’s details
and the set defaults from the Record Type or system settings
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l Default Enclose? option
—will not retain its default setting in the form and apply it to a new record.
If you set up the default Enclose option for a record toNo, then when you enter a container on the
form, the option details will be overwritten. Therefore, even though theEnclose option is not
selected on the form because of the default, the record will still revert to the container as the
Assignee andEnclosed?will beYes.
— theEnclosed? behavior is programmatically selected, i.e. not configurable usingSystem
Options. For this behavior to occur, a record’s Assignee Locationmust be equal to the record’s
Home Location. This can be achieved in a number of ways, for example, Record Type Default
Location orAdministration → System Options → Locations tab.

Method 1

a. Record Type - Default Home Location = Blank

b. System Options - RecordAssignee = Current Login

c. RecordOwner = Assignee

d. RecordHome = Assignee

e. Record Details after creation are: Enclosed? = No

f. Assignee = At Home Location: User1

g. Owner = User1

h. Home = User1

i. Right-click this record→ Location → Container.
Here you will see that theEnclosed? selection box is cleared with an informativemessage
telling you this record is currently at Home in User1.
If you choose a container, this will become its new Home Location and the record will be
enclosed automatically.

Method 2

a. Record Type - Default Home Location = Position1

b. System Options - RecordAssignee = Default Position

c. RecordOwner = Assigneed

d. RecordHome = Assigneee

e. Record Details after creation are: Enclosed? = No

f. Assignee = At Home Location: Position1

g. Owner = Position1

h. Home = Position1

i. Right-click this record→ Location → Container.
Here you will see that theEnclosed? check box is cleared with an informativemessage telling
you this record is currently at Home in ***.
When you choose a container, this will become its new Home Location and the record will be

Specifications and Limitations

Content Manager (10.0) Page 27 of 55



enclosed automatically.
When you change the Home Location, then the Assignee will keep the default Assignee
Location from the Record Type.

NOTE: TheAssociations of a Location only go up one level. You canmake the parent
Organization the default, for example, in the following hierarchy structure; Parent Organization -
Child Organization - Position – Person.
The default Organization for Person will always be Child Organization unless youmanually
make Parent Organization the default.

On a New Record form, when a user has explicitly changed the value of an Additional Field that has a
default value determined by the record Classification, and then changes the Classification, then
Content Manager does not change the Additional Field's value to the value determined by the new
Classification

Searching

l Classification Word searches – when you enter one word, it means find records whose attached
Classification contains the word

NOTE:When you enter many words, it means find records where the attached
classification contains all the words
When you type a wildcard character (*), it means find records where the attached
classification contains a word matching the wildcard character
When you type a wildcard character and one or more other words, it means find records where
the attached classification contains a word matching the wildcard and contains all the
other words as well

l Record Number Range searches – this searchmethod is a simple string searchmethod that
searches alphabetically for the values you entered, whether they are numbers or letters. Therefore, it
is essential that you know the record number pattern of the records you are looking for.
For example, when you enter a search for records in the compressed number range from 1998/1 to
1998/100, Content Manager does not return record 1998/50, because alphabetically, it is not within
the range you specified.
Workaround: When searching for a range of records using Record Number:

o use the KwikSelect on the To and From fields to select valid Content Manager record numbers,
rather than typing the numbers in.

o whenmanually entering record numbers into the TO and FROM field ensure that the record
numbers are validated (goes bold)

o use expanded Record Numbers in the To and From fields

o use the Expanded Record Number searchmethod (Numberx) as this searchmethod validates
the numbers that are entered into the To and From fields.

l Sort order of container content – subordinate items under a container that you expand with the plus
symbol are not sorted according to the criteria the container is sorted by, but by a default field. For
example, records under containers are sorted by Date Registered in descending order.
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Workaround: Right-click the container record and click Contained Records to see the container
content in a separate search window, where you can sort the records as you require.

l WhenAutomatically count results where possible on the File → Options → Search Options
tab is selected, and the user experiences delays with Content Manager returning their search
results, turning off this optionmay improve performance

l TheGo Back button executes the previous search result again and replaces the current search
result

l Content Manager applies the default sort order and filters only to new searches, i.e. from theSearch
menu or theSearch pane, but not, for example, to searches using the LocationShow,or
Classification or HoldShow Records commands

l The IDOL search engine is designed to return a fixed number of items. The default value for Content
Manager searches that use the IDOL search engine is 100,000.
The upper limit for MaxResults is 10,000,000. Any IDOL search or combined IDOL / metadata
search that includes a Content query that exceeds the limit set by MaxResults may return
inconsistent results.
You can change this figure by changing the IDOL configuration files. In Content Manager Enterprise
Studio Help, see the topic Advanced configuration of OEM IDOL about the parameter
MaxResults. Setting theMaxResults value to themaximummay impact on the overall search
performance of your IDOL and hybrid IDOL/Metadata queries.

l Saved Searches – due to the design changes made in the Searchmodule in Records Manager 8.0,
Saved Searches that have been created in TRIM 7.3x will not work in Records Manager 8.x and
Content Manager after upgrading.
A Saved Search Conversion utility has been added to the Administrationmenu in Records Manager
8.11 and is available in 8.11x or later. Administrators can run this utility to convert old versions of
Saved Searches into the correct format for Content Manager. Depending on the complexity of the
Saved Searches, the conversionmay not be successful. In particular, Action Tracking saved
searches and Communications saved searches are not converted the 8.11x or later version of
conversion utility. Searches that fail to convert are left as “old format” searches in the system. It is
recommended that organizations document their Saved Searches before upgrading.

l By design, when an existing Saved Search is overwritten, the Active Audit Log will show that Saved
Search was Deleted and a new Saved Search is added.

l Record Number Range Search - the Record Number range searchmethod is a string search and as
such there is no validation on the numbers that are entered/selected in the To and From fields. The
results returned from running a range Record Number searchmay be unexpected as there is no
validation done on string searches.
Workaround:
When searching for a range of records using Record Numbers, use theExpanded Record Number
searchmethod (Numberx), this searchmethod validates the numbers that are entered into the To
and From fields. It is also recommended that you use the KwikSelect on the To and From fields,
rather than typing the numbers in.

l Saved searches that used IDOL specific query syntax are not supported when using Elasticsearch
content index. IDOL keywords IN, PARAPGRAPH andNEAR10 are not supported, e.g.:
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o Fiona IN MsgAttachment to match "Fiona" in Email attachments

o Fiona PARAGRAPH Dugong tomatchmatching "Fiona" in the same paragraph of text as
"Dugong"

o Fiona NEAR10Chris to match "Fiona" within 10 words of "Chris"

Additionally, explicitly using IDOL field names is not supported, eg {text}:DRECONTENT, but can
be replaced with equivalent Elasticsearch field names (Content:text)

Saved searches created using IDOL specific query syntax must be recreated whenmoving to
Elasticsearch content indexing.

Report layouts

l The thickness of a line in a report layout can be controlled, but not the thickness of lines for
rectangular boxes

l The optionPrint Alternative Barcode? in the report layout barcode item properties dialog box prints
the expanded record number and therefore, applies only to record barcodes, not Location barcodes

l To print more than one page of notes orAdditional text Fields for a record, a report requires them to
be the last active item in theBand Definition list.
Its height must be greater than 1 line so that it may automatically (dynamically) increase vertically to
display all the data in the field.

l If the report layout contains more than one text field, for example, bothNotes and an text Additional
Field, the field text area in the report bandmay expand over other fields in the report, making them
illegible. The issue does not occur for the last field in the report band or when the number of
characters and/or the font size are small enough to fit all text in the text field area.

l Users in the sameContent Manager session cannot open the same report more than once
simultaneously

l Users in different Content Manager sessions, for example on different computers, can open and
modify the same report. However, only the last modification saved is retained and the administrator
will receive amail notification informing them that the document store could be corrupted.

Printing

l When printing items whose file type is set toBypass Viewer, Content Manager does not display a
confirmation dialog.
When bypassing the internal Content Manager viewer, you are printing from the associated
application. For example, whenBypass Viewer is selected forWord documents, clicking File →
Print in Content Manager prints the document. WhenBypass Viewer is not selected, the viewer
handles printing and Content Manager displays a confirmationmessage in case you have clicked
Print by accident.
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l Printing a specific page of a report is not supported in Content Manager. For example, if you are
printing a largemulti-page report and the printer has a paper jam, it is not possible to select a page or
a range of pages to reprint. Instead, you need to print the whole report again.

l When you print aWord document or an Excel spreadsheet from Offline Records, Content Manager
opens Word or Excel to print. The same behavior occurs when you right-click to print aWord
document or an Excel spreadsheet from the desktop orWindows Explorer.

l Some documents may take longer to print than others, such as large graphic files, or produce
corrupted print. For best printing results, use the original application for printing large and complex
image files where possible. The Content Manager image viewing software is designed for generic
viewing and does not produce the same viewing results as the authoring application.

l Printing reports - when selecting a different printer to print a report, Content Manager uses the same
settings as for the previous printer. KnownWindows limitation.

l Users may experience long delays when viewing or printingMS PowerPoint files from Content
Manager. As a workaround, it is recommended that they add theMS PowerPoint file extensions,
PPT and PPTX, to theBypass Viewer for these document types option on theOptions -Viewer
tab.

l If the EML file type has been added to theBypass viewer for these file types list (Options -
Viewer tab) and the user attempts to print an EML type electronic document using the right-click
Send To -Print Document option in Content Manager, it will fail to print.
Workaround: Remove EML file type from theBypass viewer for these file types list, or open the
EML document in it's native authoring application and print from there.

Content Manager viewer

l When viewing PPTX file in Content Manager Viewer where PPTX document content format
changes when previewing in Content Manager Client or printing PDF rendition.

Workaround

Add theGraphicFontScale parameter underOptions section in the formats.ini located in the
Content Manager install folder (e.g, C:\Program Files\Micro Focus\Content Manager\)and restart the
Content Manager client.

For example, GraphicFontScale=0.5

l KeyView provides different levels of support for different file formats:
—Viewing
—Filtering (the ability to extract text)
—Exporting (the ability to convert the file to HTML or XML format)
—Metadata extraction
—Detection (ability to detects its format)
Not every file format is supported for every level. This is a known limitation of a third-party product.
To use a localized version of the viewer, users should have the permission Full Control to the
Windows Program Files folder.

l When an email message contains information that is stored in a location inaccessible for the
Content Manager viewer, for example a signature on a secure Internet site, Content Manager viewer
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may not be able to display the entire message, and cannot apply retention business rules or store the
remote part of themessage.

Document Preview

A record that has an attached electronic document that is over 25MB in size will not be automatically
displayed in the View panePreview, Previous orRendition tabs on a record search results window
for performance reasons.

Workaround
If a user wants to preview the current rendition of the document, they can right-click on the record and
click View.
If a user wants to view a rendition or previous revision of the document, they can right-click on the
record and click Properties. On the displayedProperties dialog, click on the required tab e.g.
Revisions or Renditions and then view the document.

Statistics reports

l Actions deleted from Content Manager that were attached to a record before remain in the
KwikSelect → Action name list

l Record statistics reports cannot generate or export statistics if Microsoft Excel is not installed on
the computer.
Microsoft Excel components are used to export the statistics report details.

Action tracking

l Assigning a Procedure with aStart Datemay generate aStart date must not be beforemessage if
the regional settings on the PC have the time set for 12 hour time but no designation for AM or PM.

l When attaching an Action to a record with the optionAfter any Existing Record Actions for this
Record, Content Manager will start this Action after the completed Actions’ Due date, not their
Completed date.

Dates

l Content Manager supports any valid Gregorian date, back to the year 100.
Content Manager converts years from 30 to 99 to a four-digit year in the 1900s, and a year from 0 to
29 to a year in the 2000s.

Barcodes

l Foreign barcodes that contain non-printable characters are not supported, for example, tab etc.

l If a user does not haveCan Use access to a particular Location, they will not be able to change the
record’s Assignee Location using a barcode scanner

Specifications and Limitations

Content Manager (10.0) Page 32 of 55



Thesaurus

The Content Manager Thesaurus has been designed to follow the recommendations of ISO 2788 -
Guidelines for the establishment and development of monolingual Thesauri.
While every term may have as many narrower terms as a user may require, a well-designed Thesaurus
will have an appropriate number of subordinate terms, typically to amaximum of 10 to 15 terms.

l Thesaurus terms cannot contain hyphens (-).

Currency and language

l The default currency symbol set in theSystem Options → Currency tab only allows one system-
wide default to be set up

l FrenchDate Received Additional Field and checking in email - when checking in an email message,
theDate Received Additional Field of type date or date/time will be populated under all available
language variations. However, for the French version of Date Received (Date de Réception), the
accent must be used in the label of the field for it to function.

l Changing the caption of a field in Content Manager changes it in all interface languages

Tagging and dragging

l If you are performing a task on some tagged records which causes some of the tagged records to no
longer fit the search criteria for the window, then press Refresh before performing any additional tag
processing, for example, reporting, retention etc.

l Draggingmessages to a linked folder in Outlook - Content Manager may not automatically process
large numbers of items when dragged to a linkedOutlook folder.
When amail message is added to a Linked Folder in Outlook, an event starts.
There is a limitation on the number of items that can be dragged to a folder in Outlook and still start
this event, they may not all be checked in to Content Manager and error messages may not appear.
The items will, however, be added to the selected folder.
When there are unprocessed items in a linked folder, it is recommended you use theClear All
Backlogs option, to process the unprocessed items in all folders, orClear Backlogs to process just
the items in the selected folder. These two clear options are accessible from Check In Styles panel
in Outlook.

l When dragging and dropping an email onto Content Manager a different MSG file is produced
compared to those that are checked in via the Outlook integration. As a result, if theCheck for
duplicate email messages option is enabled, a warning will not be displayed if an email is checked
in twice but via different check in methods.

l When a user drags and drops the same document in quick succession, if theRecord Type has the
Behavior for Duplicate Titles set toDisplay Warning orPrevent, the warning/error stating that
there is a duplicate titled record will not be displayed as Content Manager has not completed the
Word Indexing for the first document. The user must wait for the first document to be indexed before
a duplicate title check will work.
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Interface

l Some field values appear differently depending on whether they are in a column or in theView pane.
This is because of the differing amount of space available to display the values.

l Custom toolbar icons – Content Manager does not support the creation of user drawn toolbar icons.
A wide selection of predefined icons is available.

l Status bar - staff name display - in onlinemode, the staff name is obtained from the Location’s
display name. In offlinemode, the staff name is obtained from a Location’s network login.

Locations

l It is recommended to limit the number of staff members allocated to work areas or units to 80 to 100
at each level which enables Content Manager to sort, display and refresh the screen at an
acceptable performance level.
If the number of Locations exceeds this guideline, customers should enable the Content Manager
system optionAdministration → System Options → Object Cache tab → Optimize
Performance of → Location Member Of Relationships.

l Special characters in Location names limitations:
— The percentage character (%) is supported, but may cause some inadvertent search results in
Location searches
—The asterisk character (*) is supported but may cause confusion as it is used as a wildcard
search character

l Location properties Associations tab – Content Manager does not support changing the order of
Member Of, Supervised By andDelegate Of. TheMove Up andMove Down options are only
available for theHas Members, Supervisor Of andHas Delegate items.

l Default Location cannot be changed to regular – in the Location properties Associations tab, when
an association type has only one Location, Content Manager makes it the default. To change its
status to regular, make another Location of the same association type the default first.

l User cannot choose betweenmultiple email templates for the samemail event type – if there are
multiple email templates for the samemail event type, Content Manager will use the first one
according to its name to create an email notification for the event. Users cannot choose the one to
use. Workaround: Create only one email template per event.

Alerts

Due to the design changes made in the Alerts module in Records Manager 8.1, Alerts that were created
in previous versions of Content Manager and TRIM are removed as a part of the upgrade process and
will need to bemanually redefined in Records Manager 8.1 after upgrading.

It is recommended that all Alerts are reviewed and documented before upgrading to Records Manager
8.1. This will assist you in recreating the Alerts after upgrading.
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Child Lists

A limit of 100 items applies when creating child lists, for example, a warning will be displayed if more
than 100 Contacts are added to a record. The exception to this limitation is the record Relationships,
e.g. Related To, Parts etc. child list, where the total limit is 1000 items, but only 100 items can be
applied in a single transaction.

Desktop integration

l Password protected files - password protected files (that is, the password added in authoring
application) are not supported. Password protection can cause problems with several facets of
Content Manager operations.

NOTE: Deactivating password protection does not necessarily reduce the security problem
because a prime purpose of a professional enterprise content management system is to provide
storage, retrieval and security for all registered files.

General

l Unlocked files - apparent check in discrepancy - certain applications do not lock files when in use,
for example, WinZip, whichmeans in turn that Content Manager cannot determine whether the file is
in use.
In certain circumstances, for example, when a user modifies a *.zip file after it has been checked
back in - see steps below, this may result in multiple copies of the file.
Where applications do lock documents in use - for example, Word - check in is disallowed in Offline
Records.
For example:

a. Right-click and select Edit to edit a *.zip record, for example, Test.zip, which checks out the
document for editing using Content Manager Desktop.
Content Manager automatically checks the document back in when you close the document or
authoring application. Beforemodifying the document or closing the application or document,
openOffline Records standalone and check in the *.zip file

b. In the authoring application, modify the *.zip file

c. Close the document and authoring application.
The record in Content Manager has the original document with the original contents and a new
draft document has appeared in Offline Records with themodified content.
This is the same behavior as when you delete a *.zip file fromWindows Explorer while editing
the .zip file usingWinZip.

l Checking in multiple documents using right-click Send To fromWindows Explorer may result in
theWindows error messageWindows cannot access the specified device, path, or file.
You may not have the appropriate permissions to access this item. - known limitation
caused by Windows, not limited to Content Manager.
Workaround: Send smaller file groups instead.
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l Document queues – sub-folder processing not supported. The document queue processor does
not process items in sub-folders. Instead, you will need to create a separate queue to process
this folder.

l Keyboard shortcuts for Microsoft Office 2010 applications other thanWord and PowerPoint may
not work as expected when integrated with Content Manager. This is due to limitations of those
Microsoft Office applications.

l WhenContent Manager is integrated with MS Office andMS Outlook, whether using the client
integration or using the Thin Office integration, by default a folder is created in the local user
directory C:\Users\<your user>\Documents\Micro Focus CM If this directory has it's
security locked down for users they cannot save records through the integrations.
Workaround: In the Office Integration's Preferences file, which is added to the
C:\Users\<username>\AppData\Roaming\Micro Focus\Content
Manager\OfficeIntegration directory when theOffice integration is opened, there is a property
calledMyDocumentsFolder. If a value is defined for this property, it will be used as the root
path for the CM folder. If the property has no value, then the user's My Documents folder will be
used.
The properties of the Preferences file can be defined and the file installed as a part of a network
installation process for Content Manager.

Offline Records and Content Manager Desktop

l The option File → Options → Search Options tab → Automatically view electronic
documents is not supported for Content Manager Offline Records.

l Offline Records in offlinemode andContainer icons - when a user checks out a container record to
Offline Records, the record uses the icon of the Record Type at the time of checkout.
If the icon changes in Content Manager, it is not reflected in Offline Records until the record has
been checked back in and then back out to Offline Records.

l Offline Records file path lengths –maximum lengths supported by applications - different versions of
Office and other applications have different file path length limits.
When a user saves a document in Offline Records, themaximum number of characters is
determined according to the application limit. The document namewill be truncated at whatever it
needs in order to not exceed the applications total file path length limit.
For example in Excel, the file path length is set at 201 characters including the full Offline Records
path, such as C:\Documents and Settings\user\My Documents\Offline Records (03)\folder
name\document name.xls.

l AutoCAD 2005 - when an AutoCAD 2005 file is saved to Offline Records by clickingMy Offline
Records in theSave In box, double-clicking Offline Records does not openOffline Records.
Workaround: Click theSave button to first openOffline Records and then the file can be saved to
Offline Records.

l Offline Records andMy Documents folder set as a shared folder – it is not recommended for
organizations to configure their environment so that theMy Documents folder is a shared network
resource, as Content Manager Offline Records will not work as designed, which is as a resource
when there is no network access
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l Offline Records andMicrosoft Word file names - in MSWord, the file names include the path as part
of the file name and are limited to 256 characters. This is aMSWord field length limitation.
Therefore, when you attempt to save a file using Offline Records and youmake the file name too
long, Word truncates the name to fit the 256-character limit.

l Upgrading of an older version of the TRIMTD.mdb file is not supported

l When you apply global settings, Content Manager resets offline folders to system default settings

MS Office

Microsoft Office client add-in functionality

You can use Content Manager add-ins in Microsoft Office applications. The tables show the
applications and the Content Manager add-in commands they support:

Office 2013 SP1(32-bit and 64-bit)

Feature Word Excel PowerPoint Project

Open Yes Yes Yes Yes

Save, Save As Yes Yes Yes Yes

Record Properties Yes Yes Yes Yes

Make Final Yes Yes Yes Yes

Insert Picture Yes Yes Yes No

Insert Object Yes Yes Yes No

Insert Text from File Yes No No No

Office 2016 (32-bit and 64-bit)

Feature Word Excel PowerPoint Project

Open Yes Yes Yes Yes

Save, Save As Yes Yes Yes Yes

Record Properties Yes Yes Yes Yes

Make Final Yes Yes Yes Yes

Insert Picture Yes Yes Yes No

Insert Object Yes Yes Yes No

Insert Text from File Yes Yes Yes Yes
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Office 2019 (32-bit and 64-bit)

Feature Word Excel PowerPoint Project

Open Yes Yes Yes Yes

Save, Save As Yes Yes Yes Yes

Record Properties Yes Yes Yes Yes

Make Final Yes Yes Yes Yes

Insert Picture Yes Yes Yes No

Insert Object Yes Yes Yes No

Insert Text from File Yes Yes Yes Yes

General

l ForMicrosoft Office 2013, if you have added theContent Manager web server URL from System
Options > Web services page and trying to drag and drop a Content Manager record with electronic
document using the right mouse button to any of the Office 2013 application does not give you
Move, Copy or create Hyperlink Here options.

l Default file types for integratedMicrosoft Office applications
—Excel - uses the default file type set in Excel when it is xls, xlt, xlsx, xlsm, xlsb, xltx, xltm.
When the default is different, Content Manager uses a default of xlsx in for Excel 2013 and 2016.
—Word - uses the default file type set inWord when it is doc, dot, docx, docm, dotx, dotm. When
the default is different, Content Manager uses a default of docx forWord 2013 and 2016.
—PowerPoint - pptx for PowerPoint 2013 and 2016
—Project -mpp for all versions

l Conflicts of Content Manager Microsoft Office add-ins with 3rd party add-ins – Content Manager
Office add-ins with the Office File – Close and File - Save commands. While Micro Focus does not
anticipate conflicts, nor have received reports of conflicts, there is a theoretical chance that a 3rd
party add-in that also works with these commands may conflict with the Content Manager add-in.
The Content Manager Office add-ins for MS Office 2013 and onwards do not work with these
commands, as they uses a different operatingmodel. As a result, the chance of conflict is reduced.
Customers should thoroughly test their add-ins in operation with Content Manager add-ins to identify
possible issues before running the add-ins in a production environment.
Workaround when conflicts arise: By using anMS Office custom property, users can turn the
Content Manager add-in for theMS Office applications Word, Excel, PowerPoint and Project on and
off, depending on when they need to use the add-in functionality. For instructions, see the Tech Note
at https://softwaresupport.softwaregrp.com/km/KM00640635

l In anWindows 8+ environment, printing Content Manager records (electronic documents) can only
be done from theMS Office authoring application File > Printmenu options. If a Content Manager
document is being viewed in the Content Manager Office integrationOpen dialog, printing using the
Content ManagerPrint Document option is not supported.

l Documents checked into Content Manager fromMS PowerPoint or MS Project will appear in the
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application's native Recent documents list even though they have been removed from the users
hard drive. If selected, the user will see a nativemessage.
In MSWord andMS Excel the file names will not appear in the native application's Recent
documents list.
Workaround: To access a Recent Document that has been checked into Content Manager, the user
can open it from the native application's File - Open - Content Manager - Recent Documents
option.

l Dragging and dropping documents directly from Content Manager into other applications, for
example Trapeze, is not supported.

Compound documents

l Compound documents and email – Content Manager does not detect compound documents when
checking in from supported email clients MS Outlook

l Compound document renditions – the Renditions function does not recognize compound documents
that are record renditions

l Broken links when viewing – after check in, compound document link is broken when viewing in
Word or the browser plug-in -Windows limitation

l When a user checks out a document to Offline Records and then edits the actual document, not the
link, checks in the document using theReplace Current Revision orMake a New Revision
commands and then right-clicks it and views the document using the associated application -Word -
or the browser plug-in for the viewer, the link reads Error! not a valid link.
If the viewer is the Content Manager viewer, the link works correctly, as Content Manager does not
alter a document.
In Microsoft Word (Edit → Link), the link appears as incorrect because it is pointing to the path to
Offline Records, rather than to the folder where the document actually is.
When you first check out the document and open it, theEdit → Links function inWord displays the
path to the folder where the container document is - the Offline Records folder. When you edit or
update the link, it displays the correct folder path.
If, however, youmake changes to the container document and do not edit the link, Content Manager
uses the local Offline Records path when you check the document back in, rather than the folder
path.

l Excel spreadsheets inWord documents – inWord, when trying to save the document while the
Excel spreadsheet is active, an error messagemay appear. This is due to the way Microsoft Excel
add-ins operate.
Content Manager does not detect that Word is the parent application until the user deselects and
then reselects the Excel object.

l Compound documents with broken links - if the path to a linked document does not exist or is not
resolvable, Content Manager does not detect a link at all.
If Content Manager cannot read the linked document, the link defaults toExternal To Content
Manager.
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MS Excel

l Excel and date formats - when opening and re-saving tab delimited or comma delimited files into
Content Manager using Content Manager integration, ensure that date fields are set to Text format to
avoid Excel ignoring the date format of the operating system and using US date format.
You can findmore information in theMicrosoft Knowledge Base article explaining Excel’s handling
of date formats: http://support.microsoft.com/kb/214233

l Excel Share Workbook function – Content Manager supports editing of a shared workbook only
when the workbook is checked out of Content Manager to Offline Records or edited as supercopy.
Using theEdit option in Content Manager does not check out the workbook. To edit a shared
workbook use theCheck Out andCheck In options.

l Multiple installed Excel add-ins on one computer are not supported • Microsoft Excel will not allow a
custommenu item like the Content ManagerSave, Save As andOpen commands be used if there
is a changemade in a cell and the user has not committed the change by moving out of the cell.

l Excel and Project document's - the local file does not get deleted when application is closed usingX
button:

o If you close the application using theX button, the leftover local file will not be deleted from the
Offline/Microfocus Content Manager folder.

o In casemultiple Content Manager documents are opened in office application and you close the
application usingX button then all the leftover files will be deleted except for the last one. The
leftover files are deleted when the file is closed using the File > Closemenu option.

o When you start the office application again, the add-in deletes the leftover files.

MS other

l Microsoft Binder - Content Manager cannot document content index text within Microsoft Binder
files

Thin Office Integration

l Microsoft Project – selecting an existingMicrosoft Project Template (.mpt) file using theOpen
option will cause a new project to be created based on the selected template, rather than opening the
template file for editing.
This follows the native behavior of Microsoft Project which does not support editing an existing
template file.
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Mail messaging systems

The email format checked into Content Manager is dependent on the integration being used. The email
formats captured are what themail system can provide:

Email Integration Captured File Format

Outlook integration MSG

Thin Outlook integration MSG as the native file output fromMS Outlook

EmailLink integration EML as there is noMS Outlook interaction to convert
to MSG

l Embedded email messages are treated as attachments in Content Manager. Content Manager
considers email messages that are embedded in an email message to be attachments.

l Date sent details - date sent information is stored for ExtendedMAPI compliant applications. Simple
MAPI does not provide send date information.

l Email and BCC recipients - it is possible for an email message to be sent that only has BCC
recipients.
In some cases, this can result in the email not actually being delivered because some SPAM filters
will not permit email in where the only recipients areBCC addresses.

l Microsoft Exchange support – while Content Manager does not work directly with Microsoft
Exchange, testing does includeMicrosoft Exchange andOutlook versions supported by Microsoft.
However, as there are several versions of Microsoft Exchange andOutlook, as well as many
possible Content Manager configurations, it is highly recommended that before upgrading your
Microsoft Exchange servers, you undertake thorough testing in your software environment to ensure
there are no issues.
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Microsoft Outlook

Microsoft Outlook client add-in functionality

Function Microsoft Outlook (32-bit)
2013 SP1,
2016

Microsoft
Outlook
(64-bit)
2013
SP1,
2016

Checking in to Content Manager Yes Yes

Checking in automatically from folder Yes Yes

Checking in on send Yes Yes

Content Manager email notification Yes Yes

Content Manager File/Send Yes Yes

Content Manager mail messageform/send Yes Yes

Attach Content Manager record to new message Yes Yes

l Outlook linked folders –

o Dragging an email to linked folder - the Outlook integration has a known limitation on some
mail servers which causes an error when dragging an email to a linked folder.

o Sent Items folder - it is not possible to make a link to the Sent Items folder to capture all
outgoingmessages.

TheSent Items - Content Manager folder is linked as amanaged folder internally by the
Content Manager Outlook integration. It has unique functionality for items that are added to its
collection. The user can selectively check in an item sent by them rather than all items sent from
their account. This will avoid noise emails from being checked into Content Manager, giving
users the control to selectively add their mail to Content Manager.

If all items sent from an account are to be checked in, we suggest using an Inbox rule that copies
them from theSent Items folder to another folder which can be linked to Content Manager.

l Outlook - Content ManagerSend To and signature blocks - there aremany instances where the
signature block is not included in an email, for example, Explorer → Send to → Mail Recipient or
Word → File → Send to → Mail Recipient.
This is due to the function requesting a blank Outlook form. To resolve this, when the form appears,
choose Insert → Signature.

l Date and time properties of the actual email sent or received differ to those displayed in the Content
Manager viewer. Content Manager rounds down the time to the nearest minute, while Microsoft
rounds up to the nearest minute. Therefore, the email time details in Content Manager will differ from
the actual email time by aminute.
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l Outlook email messages and document content indexing - when you check in an email message
that was saved locally in .msg format or embedded emails sent to Offline Records, Content
Manager saves them as .msg files in Content Manager format.
Content Manager indexes their content if that functionality has been applied to their Record Type.

l Outlook Send To option - when Content Manager in Outlook is enabled and a user selects Send To
from another application, themessage will be in the Outlook Outbox untilOutlook is opened and the
mail client is connected to the server.

l Check in on send is not supported when theOutlook optionSave Sent Items is not selected.

l As Microsoft does not store themessage id on sent Outlook items, items that are checked in on
send are not checked as duplicates if theSystem Option -Email Records tab -Check for
duplicate email messages is enabled.

l Simple MAPI is not supported for Outlook

l Outlook and Avaya UnifiedMessenger – the Avaya UnifiedMessenger and Content Manager In
Outlook add-ins co-exist in Outlook; however there is no Content Manager interface with Unified
Messenger itself. That means, when using UnifiedMessenger, there is no Content Manager
functionality available.

l Outlook - managing Content Manager linked folders and public folders on the Exchange Server –
when you havemultiple users linked to the same public folder on the Exchange Server and to the
sameContent Manager database then when one person drags an email to the linked folder, all the
users that have that folder linked will see the same dialog boxes as the person who is checking in
the email message.

l Outlook public folders known limitation - at times, an automation error may occur when attempting to
check in from a public folder Inbox. However, when you open the email first, you can check it in
without the error.

l If the SQL database does not allow for Unicode characters, then after checking in an email
message, Content Manager replaces Unicode characters in the email subject line with other
characters or questionmarks (?).

l TheOutlook 2013 settingCached Exchange Mode affects theMAPI document browser. When the
setting is not selected, Content Manager document queues of typeExtended MAPI Folder do not
display or process the email messages in theProcess Document Queuewindow folder when
clickingProcess to process the queue.
Workaround: In Outlook Account Settings, double-click the account. UnderOffline Settings, if
you need to keepCached Exchange Mode selected, use the slider to change the setting forMail to
keep offline.
Content Manager processes all themail that falls within the period selected here.

l Email items that have their Sensitivity set as Private and are checked in using the Content Manager
Outlook Integration are unable to have their subjects modified and will not have CM prepended once
they’ve been checked in. This cannot be rectified. A message will be in the log describing the
behavior:
"Information: Unable to change the subject of a checked in item. This item's subject will not be
suffixed with CM. Details: The object does not support this method."
All other Sensitivity types (Normal, Personal or Confidential) should be prepended with CM: Subject

l In Cached ExchangeMode, items that aremarked Check in on Send will be checked into Content
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Manager without aMessage ID. This behavior is due to Exchange saving a copy of the email that
has not yet had an Internet Message ID assigned in theSent – Content Manager folder in MS
Outlook.
If a recipient of this email checks in the receivedmessage and Content Manager is checking for
duplicate email messages, it will not trigger the duplicate warning, as theMessage ID is used to
determine duplicate emails. Subsequent recipients will not be able to check in the email as the email
will have been assigned aMessage ID.

l Users that are usingmultiple Outlook environments must ensure that their profile namematches in
all environments otherwise their Linked Folders will not work correctly.
Workaround:Users will need to re-create their Outlook Profile on themachines it does not match
on.

o CloseOutlook, openControl Panel and selectMail.

o When theMail Setup - Outlook dialog opens, select Show Profiles...

o Remove the profile that is not correctly named, click OK.

o OpenOutlook.

o TheNew Profile dialog will display, enter the correct name of the profile and click OK.

o TheAdd Accountwizard will appear. Set up Outlook.

o WhenOutlook opens, select Content Manager -> Check In Styles

o The list of Check In Styles will display. Any Linked folders that display an incorrect profile in the
Outlook Folders list will need to be removed and re-added to the Check In Style.

l Outlook integration on Surface Pro - theClear backlog andClear All backlogs buttons are not
visible.
Workaround: change the scale and layout display settings on your system.

o Navigate toStart menu > Settings > System > Display > Scale and Layout > Change the
size of text, apps and other Items and select 125% from the drop down.

o Click Advanced Scaling Settings and turn on the Let Windows try to fix apps so they're not
blurry.

Thin Outlook Integration

l When a new Appointment item is created inMS Outlook, theCheck In on Send andStyle options
are not available as an Appointment cannot be sent. If the Appointment is changed to aMeeting item
by adding an attendee, the Content Manager tab options will not be refreshed to include the Style
options.

l The option, Check In on Send, is not available on aMeeting item due to aMicrosoft limitation.

l Meeting items are not automatically deleted regardless of theDelete after check in setting on the
Check In Style used.
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Content Manager DataPort

l SeeContent Manager DataPort Help for a list of objects that are supported for import and export

l Numbering from container - the container must exist in the database before importing the record that
gets its number from the container. If you have an import source that contains both the container and
the record and the record is in either the same batch or an earlier batch than the container, the batch
of records containing that record will not be imported.

l There cannot be hyphens (-) in Thesaurus terms. If you have a Thesaurus that contains terms with
hyphens in them, modify the import file and replace the hyphens with another character before
importing, for example, underscore (_).

l Location associations – DataPort exports associations in a one-way relationship only

l DataPort does not export associatedmembers because Locations of typeOrganizationmay have
many thousands of members

l DataPort requires Integrated Windows Authentication (Active Directory) to be enabled as the
dataset authenticationmethod. If the dataset uses Explicit Windows Authentication as its
authenticationmethod, Content Manager DataPort will not work.

Content Manager Enterprise Studio

l When running the Content ManagerWorkgroup Server as executable file on a computer using
Windows Vista or later, User Account Control (UAC)may cause themessageA request to the
Content Manager Workgroup Server <name> failed: Function request <name> for Content
Manager Workgroup Server <name> failed. Failed to setup a shared memory space for the
file <path>. Access is denied. Running as user <name>. and the operationmay fail.

NOTE: Not relevant for normal Content Manager operation, when the Content Manager
Workgroup Server runs as a service, not as executable.

Workaround: Turn off UAC before running the Content ManagerWorkgroup Server as executable file.

l Time coordination - theWorkgroup Server coordinates date and time details between the client
computers and the Content Manager Servers.
It also prevents Content Manager updates when the clock is more than 10 seconds different. This
would indicate that someone has manually changed the clock on their local computer while logged
into Content Manager. If this is the case, they will need to log out and then log back in again to re-
synchronize with the network clock.
If your system clock date does not match the server date, yourWorkgroup Server access will be
denied.
Manually changing the time on theWorkgroup Server causes it to stop processing events.

l Enterprise Studio does not report that the IDOL content index is full

Specifications and Limitations

Content Manager (10.0) Page 45 of 55



Content Manager Image Scanner

l Content Manager Image Scanner applies the last used scan settings by default, regardless of the
settings in any third-party scanning applications. This behavior is by design and consistent with
other professional business applications.

Content Manager Render

l When you attempt to use rendering on a file and a dialog box appears in the file’s authoring
application, for example, asking for user details, renderingmay fail.
Workaround: Open the authoring application and answer the questions in the dialog before using it
with Content Manager Render.

l Rendering of .chm files to redactable or long-term renditions is not supported

l Renderingmay fail with the error message Failed to render document. Print job cancelled. when
the value for the setting Timeout Waiting for Result is too low, as rendering of some file types may
take longer.
Workaround: In Content Manager Enterprise Studio, right click on the affected dataset, point to
Event Processing and click Rendering. TheConfigure Rendering dialog will appear. Click the
Settings tab and set the Timeout Waiting for Result value to 180-300. Save andDeploy the
configuration file, and then restart theContent Manager Workgroup Service.

l Printing a VMBX file converts the file to a HTML file and then attempts to print the HTML file. To be
able to render a VMBX file, youmust have an application registered to handle printing HTML files.

l Known issue: Rendering aMSG file to PDF or TIFF may fail with the error messagePrint job did
not start with in the expected time interval.
Workaround: Ensure that Outlook is not installed on the Render processingmachine.

l Known issue: When printing or Rendering an Excel spreadsheet from Content Manager only the first
sheet will be printed/rendered. This may be an issue if you want a representation of the whole
document, such as a Long Term Storage rendition. This is the default behavior when printing an
Excel document fromWindows Explorer.
Workaround: see Setting Printing defaults for Excel Spreadsheets to enable them to be rendered for
a workaround. Please note, this workaround will affect printing Excel spreadsheets fromWindows
Explorer.

Content Manager Web Client

l WebClient supports drag and drop of .msg file either directly from Outlook or from the desktop.
However, the functionality is limited to Chrome andMicrosoft Edge browsers.

l When searching for records by using a phrase that contains special characters like parentheses like
[( )] or colons (:), you need to leave them out in the case of the parentheses, or escape them by using
double inverted commas around the entire phrase in the case of a colon.
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Examples: To search for a record with the title Report (2007) or Report [2007], use: title: report
2007 To search for a record with the title report: 2007, use: title: “report: 2007”

l During the record creation process, when aMSG file is attached or dragged onto the record entry
form, the Date Created field is removed from the form. This is due to a technical limitation that
prevents client side applications from extracting date relatedmetadata, such as the Date Created,
from aMSG file. However, when the file is sent to the server and finally attached to the newly
created record in Content Manager, the date relatedmetadata (Date Created) can be extracted and
is appropriately specified on the record.

l Due to the requirement to have Automatic Logon with current user name and password
authentication enabled, theWebDAV Check out and edit option does not support Guest account
access to the Content ManagerWebClient. All users must have a validWindows Domain account
that can automatically authenticate to theWeb Server.

l A known issue for Internet Explorer users accessing the Content ManagerWebClient when they
have theWindows High Contrast Black or High Contrast White themes enabled, is that some of the
buttons and icons within theWebClient are not rendered correctly and are therefore difficult to
access/use.
If a High Contrast theme is required, a workaround is to access the Content ManagerWebClient
using aGoogle Chrome browser and its High Contrast extension, if available.

NOTE: TheWebDAV Check out and edit option is only available using Internet Explorer,
so if a user is utilizing a Chrome browser to overcome the High Contrast issue, this Check
out and edit option will not be available for them.

l When searching for Content objects by a Date searchmethod using theWebClient, there is no
client side validation done on the field. This is to allow for more flexible search options such as This
Year, Last Week, Today. If a user types in invalid values into a Date searchmethod, Content
Manager will try to retrieve the objects based on the entered values.
Workaround: Use the Calendar option to select a correctly defined date format.

l Onmobile devices usingGoogle Chrome v51+ the file upload feature is not supported. Users will
not be able to create records by attaching a file using amobile device.

l TheCheck out and edit option, which uses WebDAV, is not supported when some form of load
balancing is employed to distribute requests betweenmultiple instances of theWebClient running
on different machines.
TheWebDAV feature stores the user's working copies in aWebDAV share located on theWeb
Server at URL /CMWebDAV/DAVDir/ and all requests made to that URLmust resolve to the same
WebDAV share on the same physical machine so that the user can save their work temporarily and
resume editing it before committing changes. This cannot be guaranteed when using a load
balancing configuration.

l TheWebDAV Check out and edit option does not work when using ADFS forWebClient
Authentication. TheWebDAV implementation in IIS relies uponWindows Authentication to identify
the user and does not have the ability to forward authentication requests to ADFS to determine the
user's identity. If you are using ADFS forWebClient Authentication, do not configure theWebDAV
Check out and edit feature as described inCM10.0_WebClient.pdf

l TheWebDAV Check out and edit option does not work when logged into aWindows client/Internet
Explorer browser using the sameWindows user as the Content ManagerWorkgroup server uses.
This is because the workgroup server is denied permission to read or alter the contents of the user's
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working copies.

l If Reference files (.TR5 files) that included aWebClient Classic link as theWebURLwere
generated in TRIM/Records Manager versions 7.3x or 8.1x, theseWebURLs will not open in the
WebClient after upgrading to 9.0x or above versions. A similar issue applies to Reference files that
included aWebDrawer link as theWebURL in TRIM/Records Manager versions 7.3x or 8.1x, these
WebURLs will not open inWebDrawer after upgrading to 8.2 or above versions
These limitations are due to the changes in the structure of theWebURLs, and the obsolescence of
WebClient Classic.

l The requestFiltering doesn't allow more than 2GB maxAllowedContentLength, this leaves the upper
limit of file upload to 2GB. Since this value is constraint by ASP.NET, the size of DOS file upload in
theWebClient should be less than or equal to 2GB. For more information, please see:
https://blogs.msdn.microsoft.com/friis/2013/06/19/uploading-large-file-to-iis-7-5-or-8-using-file-
input-element/

Content Manager WebDrawer

When copying and pasting a URL fromWebDrawer, or theWebClient, into anOffice 2013 or lower
version application, an error will occur when clicking the hyperlink in Office due to a knownMicrosoft
limitation.

Workaround:

Apply the fix described in

https://support.microsoft.com/en-au/help/218153/error-message-when-clicking-hyperlink-in-office-
cannot-locate-the-inte

Content Manager Workflow

l A sub-process must have at least two sub-Activities. When there is just one Activity, Content
Manager deletes the Activity and the sub-process.

l When aWorkflow template that includes document placeholders is exported from, and imported
into, a Content Manager dataset, the document placeholders are not transferred. The required
document placeholders will need to bemanually added to theWorkflow template after it has been
imported.

Content Manager for SharePoint Integration

Columns that use custom behavior

The following only affects an on-premise installation of SharePoint 2013, 2016 and 2019, it does not
apply to SharePoint Online.

If the following error is seen while trying to select a new value for one of the Integration columns:
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Then either refresh the browser page or de-activate theMinimal Download Strategy feature at Site
Settings > Manage Site features:

Content Manager for IDOL

Content Manager security options for IDOL with OGS

The following security options are not implemented in the IDOL/OGS security mapping:
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l Access exclusions on records;

l Referenced access exclusions on classifications and record types;

l Access controls inherited from client andmatter records;

l The “inherited from container + in record access control list” option.

To avoid timeouts with complex group hierarchies, manually install IDOL SecurityKeys
stored procedure

Tomanually install the stored procedure, follow the steps:

1. Right-click on the dataset where you want to install the stored procedure.

2. Navigate toSchema > Manage. TheSchema Manager dialog is displayed.

3. In the left pane, expandProcedures and scroll down toConstructSecurityKey procedure.

4. Right-click > Check and thenRecreate.

The stored procedure is installed for the dataset.

5. Click Close to exit out of Schema Manager.
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Key limits

Data storage

NOTE:
The following entities are a subset. The subset includes those key to Content Manager
operations andmost frequently of interest. Further details can be provided on request.
The number of records you can have in Content Manager is mostly limited by the RDBMS
system you are using.

* Recommended, but not strictly enforced upper limit. Beyond this limit, Content Manager has
not been tested extensively andmay be subject to performance degradation.

Entity Limit

Record Types 1024 *

Record parts 99 *

Records in container 300 *

Security levels 99

Caveats 512

External links 20

Advanced search lines 20 *

Offline Records documents 500 * per user per dataset

Offline Records folders 60 *

Versions 99 *

Decimals and currency A maximum of 15 digits before the decimal place,
up to 8 decimal places

Edit box drop-down history 25

Recent Containers and Recent Documents 25

Document content index database 10million documents per IDOL content index
server (5million recommended)
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Field length

Entity Character limit

Record Number 50

Record Type Name 50

Part Numbers 2

Foreign Barcode 30

NOTE: This entity supports multiple barcodes
that can be upto 30 characters each separated
by a semicolon(;).

Record Title (structured text) 1024

Record Title (free text) 1024

Thesaurus Term 100

Classification Plan number 10

Classification Plan level name 260

Security Level Name 50

Security Caveat Name 50

Person Surname 100

Organization Name 200

Group Name 200

Position Name 200

Location Telephone Number 30

Location Email Address 255

Person Initials 25

Logs in as (user name plus domain name) 255

Entity Character limit

Notes 65536

External reference 50
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Workflow Name 512

Workflow Activity Name 100

Retention Schedule title 200

Retention Schedule number 30

Consignment number 50

Priority 5

Additional text Field 65535

Lookup Set name 50

Lookup Set items 1024 *

Index word 50
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Obsoleted Features

Records Manager 8.3

l SoapWeb Service - replaced by ServiceAPI

l Directory Synchronization - In Records Manager 8.3, RM Directory Synchronization has been
obsoleted. The Instant On feature introduced in RecordManager 8.2 provides an alternativemethod
for adding new users to RecordManager.

Customers should assess if Instant On satisfies requirements for onboarding users to Records
Manager. Alternatively, Records Manager APIs provide the necessary integration points for
customers to develop their own custom integration solution.

l Worksite Integration is no longer a part of the Hewlett Packard Enterprise Product Portfolio.

l iUS Integration is no longer a part of the Hewlett Packard Enterprise Product Portfolio.

l COMSDK ActiveX controls - these were removed from support in Records Manager 8.2, but
continued to be supplied. Records Manager 8.3 will begin the process of removing this code where it
is no longer required for our own internal use.

Content Manager 9.0

Obsoleted Features

l WebClient Classic has beenmade obsolete in Content Manager 9.0

Obsoleted Platforms

l Microsoft Office 2007

l SharePoint 2010

l Internet Explorer 10

l Microsoft Server 2008 R2

l Microsoft SQL Server 2008 R2
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Content Manager 10.0

Obsoleted Platforms

l Kofax 10.x

l Microsoft Office 2007

l Microsoft Office 2010

l SharePoint 2010

l Internet Explorer 10

l Microsoft Windows Server 2008 R2

l Microsoft Windows Server 2012 (64-bit)

l Microsoft Windows Server 2012 R2 (64-bit)

l Microsoft Windows 7 SP1 Professional or Enterprise

l Microsoft Windows 8 Professional or Enterprise

l Microsoft Windows 8.1 Professional or Enterprise

l Microsoft SQL Server 2008 R2

l Microsoft SQL Server 2012 SP3

l Microsoft SQL Server 2014 SP1

l Oracle 11g R2

l Oracle 12C

Specifications and Limitations

Content Manager (10.0) Page 55 of 55


	Specifications
	Introduction
	Recommended minimum requirements
	Main applications
	Content Manager client (32-bit)
	Content Manager client (64-bit)
	Content Manager Workgroup Server (64-bit)

	Peripheral applications
	Content Manager Web Client Server (64-bit)
	Content Manager Web Client Browser Support
	Content Manager for SharePoint (64-bit)
	Content Manager Service API
	Content Manager WebDrawer (64-bit)

	Integrations
	Content Manager Office integration
	Content Manager Zero foot print Office add-in
	Content Manager EmailLink email integration
	Content Manager ArchiveLink integration (64-bit)
	Content Manager Kofax integration (32-bit)
	Content Manager Warehouse integrations (64-bit)
	Content Manager IDOL integration
	Elasticsearch
	ControlPoint integration with Content Manager (64-bit)
	Structured Data Manager integration with Content Manager
	EMC Centera integration (64-bit)
	Content Manager document viewer supported file formats
	64-bit support
	Other Environment


	Relational Database Management System (RDBMS) requirements
	Supported RDBMS servers (64-bit)
	Minimum Requirements for database access
	Supported RDBMS clients (64-bit)
	Special Database Considerations


	Limitations and Behaviors
	Authentication
	Product Accessibility
	Supported Languages
	Installation
	License Keys
	Help
	Access control and security
	Records and containers
	New Record forms
	Searching
	Report layouts
	Printing
	Content Manager viewer
	Document Preview
	Statistics reports
	Action tracking
	Dates
	Barcodes
	Thesaurus
	Currency and language
	Tagging and dragging
	Interface
	Locations
	Alerts
	Child Lists
	Desktop integration
	General
	Offline Records and Content Manager Desktop
	MS Office
	Microsoft Office client add-in functionality
	General
	Compound documents
	MS Excel
	MS other
	Thin Office Integration

	Mail messaging systems
	Microsoft Outlook


	Content Manager DataPort
	Content Manager Enterprise Studio
	Content Manager Image Scanner
	Content Manager Render
	Content Manager Web Client
	Content Manager WebDrawer
	Content Manager Workflow
	Content Manager for SharePoint Integration
	Content Manager for IDOL
	Key limits
	Data storage


	Obsoleted Features
	Records Manager 8.3
	Content Manager 9.0
	Obsoleted Features
	Obsoleted Platforms

	Content Manager 10.0
	Obsoleted Platforms



